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Starting a new publication 
Exercise 1 
Follow the steps below to start a new document with these settings: 
 Page size: A4 Margins: 0.8" (20mm) all round 
 Double-sided Facing pages Number of pages: 5 

 

File!New (Note: This means choose New on the File menu). 

The Document Setup dialog box is displayed: 

 

 
 

•  Click  in the Page Size box and choose the page size. Page Size is set to Custom if you set your own 
values in the Dimensions boxes. The maximum Dimensions values are 42 × 42 inches (106 × 106 cm) 

•  Set the Tall button for a page like this:  or Wide for one like this:  

•  Check Double-sided for the page layout used in books, newspapers and magazines 

•  Check Facing pages to see the pages that face each other in a double-sided publication 

•  Set values for the margins in the Inside, Outside, Top and Bottom boxes 

•  The Numbers button allows you to set choose a style for page numbers 

•  You can also set the Number of pages and the Start page # (number) to start working with (you can 
always add more pages later) 

•  Choose the printer you are composing the document for. Note that this should be the final target printer, 
not the printer that you use to proof your document 

When you have chosen all your settings, click OK. The PageMaker window is displayed. See the next page. 



 

PM65 Intro.doc, 11/07/2003 12:19 PM 2 

The PageMaker window 
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Changing  margins and other page attributes 

To make changes after starting a new publication: File!Page Setup, Make changes, and click OK 

Saving a new publication 

It is a good idea to save your work periodically. To do this: 

i) File!Save as to get the Save publication as dialog box 

ii) Select the folder or directory, type the file name into the File name box and click Save 

Exercise 2 
Save your publication as EX3 in the My Documents folder 

Setting program and document preferences 

File!Preferences while no document is open allows you to set preferences for all new documents. 

File!Preferences while a document is open allows you to set preferences for that document. 

Exercise 3 
Set the following preferences: 
•  Measurements in to suit yourself 
•  Click More and set Greek text below to 2 



 

PM65 Intro.doc, 11/07/2003 12:19 PM 3 

Setting and using guides 
There are three kinds of guide to help you accurately place items and draw graphics: 

Margin guides are magenta. Set via the New document dialog. 

Column guides are blue. Left and right column guides are automatically set on top of the left and right 
margin guides. Set via Options!Column guides. 

Ruler guides are green. Drag horizontal and vertical guides from the rulers. 

To help you set ruler guides you may want to reset the zero on one or both rulers, just as an ordinary ruler 
usually measures from its zero. 

Changing the rulers' zero point 

Exercise 4 
Follow the steps below to set the rulers' zero point to the intersection of the margin guides 

i) View!Guides and Rulers and make sure that Zero lock is unchecked. 

ii) Drag from the zero box to where you want the new zero: 

 

As you
drag, the

ruler
shows

where you
are

  
1. Point to the zero box and 

hold down the left button 
2. Drag to the new zero point, checking the 

rulers for the exact values you want 
3. Release the mouse button 

and the zeros are reset 

Setting ruler guides 

Drag from the rulers to the desired position (again, the ruler shows you where you are): 

    
1. Point to the ruler 2. Press the left button 3. Drag to position 4. Release button 

Locking ruler guides 

To prevent guides being moved by accident, View!Lock guides 

Exercise 5 
•  Drag ruler guides so there is one 1" (25mm) inside each margin 

(as in the diagram) 
•  Lock the guides 

 

Snapping to guides 

When objects are drawn or dragged near to guides, they are drawn to the 
guides like steel to a magnet, provided that Snap to guides on the View menu is checked. 

 

Exercise 6   Make sure that Snap to guides is on 
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Working with graphics 
You can import pictures (scanned drawings and photographs, or pictures created on a computer) into a 
PageMaker publication using the Place command. 

Placing graphics 

Exercise 7 
Follow the steps below to place the graphic Logo.tif (in the C:\PM65\Extras\Tutorial\Lesson1 

folder) in the centre of the page 
 

i) Select the pointer tool,  

ii) File!Place. The Place 
dialog box is displayed 

iii) Select the file to place 
(make sure that it is a 
graphic) and click Open. 
The cursor changes shape 
depending upon the type of 
graphic chosen: 

 indicates a paint-type 
(bitmapped) graphic 

 indicates a draw-type 
(vector) graphic 

 (Mac: ) indicates a 
TIFF (Tagged Image File 
Format) graphic 

 (Mac: ) indicates an 
Encapsulated PostScript file 

iv) Click at top left hand corner of position desired or drag a rectangle with the mouse 

 
Moving graphics 

i) Select  
ii) Drag the graphic to desired position 

Exercise 8 
Move the graphic so that is is 1′′  (25mm) from the top and the right 
margins 

 
Resizing graphics 

 

The little squares at each corner and side are called handles 

•  Drag a corner handle to change size in both dimensions. 

•  Drag a centre handle to change horizontal or vertical size only. 

•  Hold down Shift while dragging to maintain proportions. 
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Or you can use the Control Palette:  

 

Click  or enter values or % in W and H, then click  or press the Return key, ↵ . 

The centre of resizing is determined by the node selected in  

Exercise 9 
Adjust the graphic so that it is 2" (50mm) wide and 1.25" (31.1mm) high but still on the margins 
Deleting graphics 

Select , click on the graphic and press the Delete key on the keyboard 

Some basic techniques 
The pasteboard 

Items can be kept on the pasteboard and moved between the pasteboard and a page. 

Changing the amount of detail you see 

There are three ways of doing this: 

•  Select the Zoom tool, , and use it either to click where you want to zoom into or to drag an area that 
you want to zoom to. Hold down Ctrl to zoom out. You can select the Zoom tool temporarily by holding 
down Ctrl and the Spacebar. Add Alt to zoom out. 

•  You can open the View menu and use the various Zoom commands. 

•  You can also use the following keyboard shortcuts: 

 

Toggle between Actual size and Fit in window Ctrl+click right mouse button 
(Mac: "+Option+click) 

 

Zoom factor: In Out Fit in window Actual size 50
% 

75% 200% 400% 

Ctrl/" + = - 0 1 5 7 2 4 

 
Moving around 

To 

Move the window in any 
direction using the grabber hand 

Do the following 

Alt/Option and drag or choose  and drag 

Move the window horizontally or 
vertically using the grabber hand 

Alt/Option + Shift and drag 

Move to a specific page Click on its icon. eg, click on  to move to page 2 

Move to the next page 

Move to the previous page 

Go to page ... 

Page Down 

Page Up 

Ctrl+Alt+G 
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Creating graphics in PageMaker 
Exercise 10 
Follow the procedures below to draw the following: 
•  A circle of 1" (25mm) diameter, line 4pt and a solid black fill with a 20% Tint 

•  A square of 1" (25mm) side, line 5pt and fill with  
i) Select the appropriate drawing tool: 

  to draw a straight line  to draw a straight line horizontally, vertically or at 45° 

  to draw a rectangle. Double-click the tool to set 
rounded corners 

  to draw an oval or ellipse 

  to draw a polygon or star. Double click the tool to 
set number of sides and star inset 

ii) Press the left button where you want to start the object 

iii) Drag to where you want it to end and release the button  

Changing the fill and stroke of a graphic 

i) Select the graphic using the  tool 

ii) Element!Fill and Stroke to display the dialog box: 

 then: 

Choose a fill type from 
the Fill box and Tint 
from the Tint box 

You can also set stroke 
and fill types before you 
draw an object 

 

Choose a stroke type 
from the Stroke box  

You can also set these 
attributes separately 
using the Stroke and 
Fill commands on the 
Element menu 

 
Moving drawn graphics 

Select , point to a filled part of the graphic or to its outline and drag. 

Exercise 11 
Move the circle so that is in the 1in (2.5cm) square of guides at the bottom left and move the 
square so that is in the square on the right (see picture at top of next page) 

Resizing graphics 

To change the size of a graphic, select it and drag one of its resizing handles. 

Hold down shift to force the graphic to stay, or become, a circle or a square. 

Hold down the Shift key to force  

 to draw squares,  to 
draw circles and   to draw 
regular polygons/stars 
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Importing text from a file 
You can import text from any word processor file type that PageMaker has a filter for, including plain text 
files. 

Exercise 12 

i) Open the Layout menu and make sure that Autoflow is 
OFF (no # beside it) 

ii) Follow the procedure below to place the file 
C:\PM65\Extras\Tutorial\Lesson1\text.rtf so that it is 
positioned between the margins and below the top 
graphic as shown on the right: 

 
 

i) File!Place. Get the Place 
dialog box: 

 

 

ii) Get the file you want in 
here. Then click Open to 
place it. Click Cancel to 
close the dialog without 
placing 

 

 

iii) If the format of the file is 
not recognised, you will be 
asked to choose one. Once 
you have done this, the 
mouse cursor changes into 
one of the following icons 

 

 = Manual flow (if Autoflow on the Layout menu is off). The flow of text on to the page 
will stop at the end of the current column, showing the �more text to place� windowshade 
handle,  

 = Autoflow (hold down " (PC: Ctrl) to switch to Manual). Text will flow on to the page 
without stopping and PageMaker will add pages if necessary to fit it 

 = Semi-automatic flow (Get by holding down Shift). The flow of text on to the page will 
stop at the end of the current column. The mouse cursor will stay as  

iv) At this point you can either click at the vertical position you want for the text in which case 
PageMaker will run the text from the left to the right of the column you are in or you can drag a 
rectangle in which to place the text. 
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Moving, resizing and reshaping text blocks 
Moving a text block 

 

i) 

 

Select the pointer tool 
 

 

 

ii) 

 

Move the mouse cursor into the text block 
 

 

 

iii) 

 

Press the left mouse button and drag the 
block to its new place 

 

 

Iv) 

 

Release the mouse button 
 

 

 
Change the size and shape of a text block  

When you select a text block with the pointer tool, windowshade handles appear at the top and bottom of the 
text block. Resizing handles appear at each corner: 

Drag these
windowshade
handles up or

down to change
the height of the

block

Drag these
resizing

handles in
any direction

to change
the shape of

the block  
 

 

Exercise 13 
Resize/move the text block so that is is positioned between the ruler guides as follows, 
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Text flow 

A story can consist of a number of separate text blocks. These can be placed anywhere in different columns 
or different pages. 

There are four different kinds of text block you can have in a story: 

 

The first text block in a story has  at the top. 

 

Blocks in the middle of a story have  at the top and 

 at the bottom. 

 

The last text block has  at the bottom. 

 at the bottom means that there is text in the story that hasn't 
yet been placed. The windowshade handle is coloured red. 

To place the rest of the story, click the triangle and then place it  
 

Changing the number of columns on a page 

i) Layout!Column guides... to display: 

 
ii) Set Number of columns and Space between columns to the values that you require.  
 

Exercise 14 
i) Move to page 2 by click its icon in 

 
ii) Turn Autoflow ON (Layout!Autoflow) 
iii) Set the number of columns to 3 
iv) Place the story 

C:\PM65\Extras\Tutorial\Lesson1\text.rtf in 
column 1 starting at the top left hand corner. 

v) Drag each of the windowshade handles down 
and up in turn and observe what happens to 
the text 
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Breaking a one-block story into more than one block 

i) Select the block with the pointer tool,  

ii) Roll up the bottom windowshade handle until the block contains only what you want in it 

iii) Click on the bottom handle (which is now red). The mouse changes to  or  

iv) Place this new block in the usual way (see page 8) 

v) Repeat from (ii) with the new last block 

Exercise 15 

i) Set the number of columns to 2 

ii) Move to page 3 

iii) Place the story 
Tutorial/Lesson2/E&wtext.rft 

iv) Break this story into three blocks and 
arrange them as shown on the right 

v) Save the publication as EX15 

Block 1 Block 2

Block 3

 
To reflow a story that has already been placed 

i) Select the last text block with the pointer tool,  

ii) Drag the bottom windowshade handle up to that it meets the top handle 

iii) Repeat for the remaining text blocks 

iv) Click the bottom windowshade handle of the first text block and reflow the story 

Exercise 16 
Rejoin into one block the three blocks from the last exercise 

To break a story into two or more stories 

When a story is separated into blocks, it still remains one story. Sometimes, you want to break a story into a 
number of distinct stories. Do this as follows: 

i) Use the  tool to highlight the text you want to take out of the story or use  to select a block of 
text 

ii) Edit!Cut 

iii) Either click or drag a rectangle where you want the text to go 

iv) Edit!Paste 

Exercise 17 
i) Break the story from the previous exercise into two stories of equal size, one in the left 

column and one in the right column 

ii) Check that the two parts really are two stories: select , Edit!Select all and then examine 
the windowshade handles 

To join two separate stories into one 

i) Select one story 

ii) Edit!Cut 

iii) Click an insertion point in the other story where you want the text to reappear 

iv) Edit!Paste. See next page for exercise 
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Exercise 18 
i) Join the two stories from the previous exercise into one 

ii) Check that there is only one story by selecting  and Edit!Select all 
Getting out of trouble with text blocks 

Most problems with text blocks arise because they get too fragmented. You can use the following two 
techniques to get all the text in a story into one block: 

Method 1: Find the first block in the story 

 Resize it so that it is big enough to hold all the text 

Method 2: Click an insertion point in any block with  

 Edit!Select all then Edit!Cut and Edit!Paste 

Typing text into a document 
This can be done either in the place in the publication that you want it or by using the Story Editor. 

Typing text directly onto the page 

i) Select the text tool,  

ii) Either click at the vertical position you want for the text in which case text will run from the left to the 
right of the column you are in or drag an imaginary rectangle to mark the left and right boundaries of the 
text. A flashing vertical line appears at the place that text will go onto the screen. This is called the 
insertion point 

iii) Type the text, remembering that words will wrap to the next line automatically 

Exercise 19 

i) Select  and click an insertion point at  the top of page 1, where the margins meet on 
the left 

ii) Type in the following text: 
PageMaker Exercises by <your name> 

Typing in a new story using Story Editor 

The Story Editor is a built-in word processor. It includes facilities such as Search and Replace and Spell 
Check. Stories can also be imported directly into Story Editor. To use it: 

i) Edit!Edit Story 

ii) Type in story 

iii) Story!Close Story to close Story Editor 

iv) Click Place button and follow step (iii) in Importing text 

Checking spelling 

In Story Editor, Utilities!Spelling and follow the dialog 

Searching and replacing 

In Story Editor, Utilities!Find to search for text 
 Utilities!Change to replace text 

Exercise 20 
In the story on page 2, replace all occurences of Lorem Ipsum by LLLLL IIIII 
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Editing text 
Editing text on the page 

Select  and then click where you want to place the insertion point, drag to highlight, etc. (See next page 
for details) 

Editing text using Story Editor 

NOTE: You can arrange the layout window and the Story Editor window so that both show at the same time 

iii) To edit a story using Story Editor, 
either triple-click on the story with the pointer tool 
or click on the story with  or  then press Ctrl+E (Mac: "+E) or Edit!Edit Story 

iv) Use the usual word processing techniques to insert, delete and select text. 

v) To return to layout view, Edit!Layout or Ctrl+E (Mac: "+E) 

vi) You can see hidden characters such as tab ($), space(·) and paragraph marks (¶) by choosing Display ¶ 
on the Story menu. 

NOTE: The following apply to both Layout view with  and to Story Editor view 

Moving the insertion point in a story 

To move Press To move Press 

One Word Left Ctrl (Mac: ")+% To Next Line & 

One Word Right Ctrl (Mac: ")+$ Up one Paragraph Ctrl (Mac: ")+' 

To Previous Line ' Down a Paragraph Ctrl (Mac: ")+& 

Selecting text with the keyboard 

Hold down Shift while moving the insertion point as above 

Selecting text with the mouse 

To select  Do this 

Any text Drag across the text you want to select or click at one end of the text, hold down Shift and 
click the other end of the text 

A word Double-click the word 

A paragraph Triple click in the paragraph text 

Whole story Click in story, then Edit!Select All or Ctrl (Mac: ") +A 

Moving and copying text 

i) Highlight the text to move/copy then Edit!Cut/Copy or Ctrl (Mac: ") +X/C 

ii) Click where you want the text to go then Edit!Paste or Ctrl (Mac: ") +V 

Exercise 21 
In the story on page 2 of the publication, move the second paragraph so that it comes before 
the first 
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Character formatting 
The Font (typeface) determines the shape of text characters. The Size sets the size in points. The point 
(abbreviated pt) is the standard unit of size in typesetting. 1 inch = 72 points. Exanples: 

23 point Times New Roman 28 pt Arial 
Type Style includes Bold, Italic, Underline, Strikethrough or any combination. 

You can set Position to be subscript or superscript, Case to be ALL CAPS or Small Caps. 

Set width, Leading and Track are dealt with under Typography. 

Setting character formatting 

i) Select text 

ii) Type!Character.... Get the Character Specifications dialog box: 

Click and
choose a font

Enter, or select, the
size here.

72 points = 1 inch

Click on one or
more boxes to
set/unset style.

 is on

Click here to
change

settings for
Subscript,

Superscript,
and Small

Caps

Click to
change
position

 
iii) Make changes required and click OK 

 

You can also use the  Control Palette with the T button pressed: 

 
Some keyboard shortcuts 

To change type size 
One point smaller 
One point larger 
 

On the PC, press  
Ctrl+Shift+<  
Ctrl+Shift+>  
 

On the Mac, press 
"+Option+ Shift+, (comma) 
"+Option+ Shift+. (full stop) 
 

To format text as 
Normal  
Bold 
Italic 
Underline 

On the PC, press 
Ctrl+Shift+spacebar 
Ctrl+Shift+B 
Ctrl+Shift+I 
Ctrl+Shift+U 

On the Mac, press 
"+Shift+spacebar 
"+Shift+B 
"+Shift+I 
"+SHIFT+U 

 

Exercise 22 
•  Format the headline on page 1 so that it is in a Sans Serif font and runs from one margin 

to the other 
•  Format the text on page 2 in Times New Roman at a size to fill all the white space 

between the graphics 
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Paragraph formatting 
A paragraph is a block of text up to the next paragraph mark (return), which is represented by ∂ when you 
Display ∂ in Story Editor. Paragraph formatting is a property of whole paragraphs.  It allows you to change 
the shape of blocks of text, space before and after paragraphs and other aspects of the layout of paragraphs. 

Alignment examples 

Left 
A desktop publishing system transforms the way you produce business documents, by 
allowing you to turn out high-quality printed material much faster and at lower cost. Desktop 
publishing is now used in very many companies, in a variety of ways: marketing 
departments use it to produce marketing literature, 

Justified 

Graphics programs are used to create images of various kinds.  Graphics programs include 
Paintbrush, Corel Draw, Freelance, Harvard Graphics and many more.  Another source of 
graphics is an image scanner - a device which converts a graphic on paper into a computer 
graphic. 

Centred 
Desktop publishing software runs on standard business computer  There are a range of 
desktop publishing programs, varying in cost, capabilities and ease of use.  Generally a 
desktop publishing program is used in conjunction with word processing programs (to 

produce the text) and graphics programs (to produce the pictures). 

Right 
Word processing programs are used to enter and edit the basic text.  There are a huge range 
of word processing programs, including Word, DisplayWrite, WordStar, and WordPerfect.  

Word processing programs offer specialised editing facilities, such as Spell checkers and 
Search and Replace functions. 

 

Force Justified 
When it comes to printing, desktop publishing gives you a range of choices.  You can use an 
inexpensive dot-matrix printer for producing page proofs.  Or use a laser printer to produce 
near-quality pages, which for most purposes will be the highest quality you will ever need.  
For special documents where only the very highest quality is good enough, you can output 
pages to phototypesetting machines like the Linotronic 100 or Linotronic 300.  These pages 
can then be used to make plates for high-quality c o n v e n t I o n a l   p r I n t I n g 
 
 

Indentation examples 

Left indent of 1cm 
A desktop publishing system transforms the way you produce 
business documents, by allowing you to turn out high-quality printed 
material much faster and at lower cost. Desktop publishing is now used 
in very many companies, in a variety 

Right indent of 1cm 
Graphics programs are used to create images of various kinds.  
Graphics programs include Paintbrush, Corel Draw, Freelance, Harvard 
Graphics and many more.  Another source of graphics is an image 
scanner - a device which converts a graphic on p 

First line indent of 1cm 
Graphics programs are used to create images of various kinds.  

Graphics programs include Paintbrush, Corel Draw, Freelance, Harvard Graphics and many 
more.  Another source of graphics is an image scanner - a device which  

Setting paragraph formatting 

i) Select paragraphs by clicking an insertion point for one, highlighting for more than one. 

ii) Type!Paragraph to display the dialog box: 

Put indent
settings in

these boxes

Put space before and
after paragraphs here

Select
alignment

here

Click here to
put lines

before/after
paras

Use these to
control how
paragraphs

split over pages
and columns

Click here to
change

kerning and
tracking
options

 

 

iii) Click OK when done 

Or you can use the Control Palette with the ¶ button pressed: 
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Setting tabs 

i) Select paragraphs you want to set tabs for 

ii) Type!Indents/tabs. Get the Indents/Tabs dialog box: 

Click
button
for tab
type

Click here to
set tab

Click to
choose/set leader

Click to clear
all tabs

Click here
or other end

to scroll
ruler

Click to Add, Delete,
Move or Repeat

 
To set indents drag the upper of  to set First, the lower to set Left and  to set the Right indent 

Exercise 23 
•  Remove the extra line space between each paragraph in the Page 1 story. Set Space After 

to 0.2� (5mm). 
•  Set First Indent to 0.1� (2.5mm). Set Alignment to Justified. 

Master pages 
Anything that is placed on a master page appears on all corresponding publication pages unless you uncheck 
Display Master Items on the Page menu for that page. You can place text, graphics, and page numbers on 
master pages. You can also set ruler guides. 

Working with master pages 

Click  to work on the left master page. Click  to work on the right master page. Do not forget to move 
back to a document page when you have finished. 

Removing master items from a document page 

View!Display master items to remove the #. If you change your mind, repeat to turn on again. 

Page numbers 

To place a page number code on a master page so that publication pages are automatically numbered, 

i) Select left master page 

ii) Select  and click an insertion point or drag a text area 

iii) Press Ctrl+Shift+3 (Mac: "+Option+P) Get LM code inserted. Format it in the same way as you would 
ordinary text. You can also add any other text you want, such as the word Page etc. 

iv) Repeat for right master page. 

Exercise 18 
On each master page 
i) Place a 0.5 point rule 0.1� (2.5mm) 

below the bottom margin 
ii) Place a page number code 0.125cm 

(0.05 in) below the rule and flush with 
the outside margins (see right) 

iii) Suppress the master items on page 1 
iv) Check that all other pages are numbered 

and have the rule on them 
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Typography 
Leading 

 
This is the vertical distance from one line of text to the next. The default is 
120% of the font size so that, for example, 10 point text will be set on 12 point. 

Setting leading 

i) Highlight text 

ii) Type!Leading or Type!Character... 

iii) Select or enter the leading value in points. Auto gives the default value. 

Viewing leading 

Drag through a line of text with the text tool. The height of the highlighted area shows the line's leading. 

Exercise 19 
Type in the following so that they describe themselves: 
i) This sentence is in 30 point Times New Roman on 30 point leading 
ii) THIS SENTENCE IS IN 16 POINT ARIAL AND ITS LEADING IS SET SO THAT 

THERE IS NO SPACE BETWEEN THE LINES 
Kerning 

Kerning is the process of adjusting the space between letters to take account of their different shapes. 
Kerning can be done manually between a pair of letters, over a range of selected text, or for a whole story. 

Manual kerning is additional to automatic pair kerning which adjusts the space between the pairs of letters 
defined by font designers as kern pairs for all type larger than the value in the Spacing attributes dialog box 
which is displayed by Type!Paragraph!Spacing. In general, automatic kerning should be on for text that 
is larger than body text. 

Manual kerning 

To kern letters manually, select the text to change (if 2 characters click between 
them), and use the following keyboard commands to add and remove space 
between the letters:  

To Press  
 PC Mac 
tighten by 0.01of an em Alt+( Option+( 

loosen by 0.01 of an em Alt+) Option +) 

tighten by 0.04 of an em Ctrl+Alt+( "+ Option +( 

loosen by 0.04 of an em Ctrl+Alt+) "+ Option +) 

remove all manual kerning Ctrl+Alt+K "+Opt+K 

1 em is a width equal to the current point size. So, in 12 point text, 1 em = 12 points; in 72 point text, 1 em = 
72 points 

Exercise 20 
i) Key in the word Work. Set the letter W to 72 pt and the rest of the word to 24 pt 

ii) Zoom in close and kern so that the space between W and o is the same as the rest 
of the word: 

 W ork 

VA is tighter 
AV is looser 
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Tracking 

Tracking allows you to adjust the letter spacing within a selected range of text  

Tracking is applied using one of five "tracks," or standardised adjustment curves. 
The default value is "No track," which leaves the current spacing as is. "Normal" 
adjusts larger font sizes more than smaller sizes because the larger the font size, 
the tighter the tracking should be. The tighter the tracking, the shorter the line of 
text. 

This is Very 
loose 
This is 
Loose 
This is 
Normal 
This is Tight 
This is Very tight 

Changing tracking 

i) Select text 

ii) Type!Expert Tracking 

iii) Choose tracking mode 

Keyboard shortcut for no tracking: Ctrl+Alt+K (Mac: "+Option+K) 

Exercise 21 
Try different tracking settings for the first sentence from Exercise 19  

 
Changing character width 

To squash or expand text, 

i) Type!Horizontal Scale 

ii) Select a % to change by or select Other and enter between 5 and 250 

iii) Click OK  

 
Baseline alignment 

It is good typesetting practice to align the bottom of columns. Use the following technique if headings or sub-
headings throw columns out of alignment. 

i) Select paragraph(s) which are causing the problem 

ii) Type!Paragraph!Rules!Options 

iii) Check Align to grid 

iv) Set Grid size to be the leading of the body text 

v) Ctrl+Alt+Click OK to close the dialog boxes 
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Frames 
Frames were introduced into PageMaker at version 6.5 to provide another way to position text and graphics. 

Exercise 22 
i) Move to page 4 
ii) Follow the procedures below to recreate page 3 (see page 10 for details) on page 4 but 

this time using frames 
iii) Add another frame in the centre of the page and import logo.tif into it 

Creating a frame and importing text or a graphic 

i) Choose one of the frame tools: ,  or  

ii) Draw the frame 

iii) File!Place... 

iv) Select the file to place 

v) If the frame you want to place into has been deselected, click on it 

Linking frames 

i) Draw another frame 

ii) Click the bottom windowshade handle of the frame that you want to link from. The mouse changes to  

iii) Click the frame that you want to link to 

NOTE that you can only link to empty frames 

Modifying frames 

i) Select the frame using  

ii) Element!Frame!Frame Options... to display the dialog box: 

For text For graphics 

  
iii) Make the setting you want and click OK 

Formatting frames 

Right-click the frame and select a formatting command from the short-cut menu. 

 



 

PM65 Intro.doc, 11/07/2003 12:19 PM 19 

More work with graphics 
Advanced resizing 

i) Hold down Ctrl (Mac: ") while resizing bitmap graphic types to match resolution to target printer and 
avoid unwanted patterning effects. 

ii) To restore a graphic to its original proportions, hold down Shift, click a handle, and release the mouse 
button when the cursor changes to a double-headed arrow. 

Cropping graphics 

To trim the sides of a graphic: 

i) Select  

ii) Drag handles to crop picture as desired 

Duplicating graphics (or text blocks) - basic 

Simple duplication of selected graphics can be done by Edit!Copy followed by Edit!Paste. 

This gives a second copy, offset by 0.1" horizontally and vertically. 

Duplicating graphics (or text blocks) - multiple copies 

To place graphics at a constant displacement of any amount: 

i) Select graphic(s) to duplicate. 

ii) Edit! Paste Multiple... 

iii) Set offsets and number of copies 

iv) Click OK 

Exercise 23 
Draw a square of side 3cm and duplicate it so that a series of square runs down the diagonal 
of a page. 

Inline graphics 

A graphic can be inserted as part of a text block as follows, 

i) Select  

ii) Click an insertion point 

iii) File!Place etc 

Exercise 24 
i) Draw a circle and fill it red 
ii) Edit!Copy to place it on the Clipboard 
iii) Type This is a red circle and then paste the circle as the next character 

Types of graphic: TIFF, EPS, etc 

Tagged Image File Format (TIFF) graphics are bitmapped, so that their appearance in print depends critically 
upon their size. They can be printed on any printer. 

Encapsulated PostScript (EPS) are vector-type graphics which may be resized in any way desired without 
losing quality. They print only on a PostScript printer. 

Windows Metafile (WMF) are draw (vector) graphics in a standard Windows format. They will print on 
almost any printer. 
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Text and graphics 
Reversed text 

i) Draw rectangle a little larger than text block to be reversed 

ii) Element!Fill!Solid 

iii) Select text with  tool 

iv) Colour it, say, green, so that it stays visible 

v) Drag it on top of rectangle 

vi) Adjust as necessary 

vii) Set Type!Type style to and click Reverse 

You may need to send the rectangle to the back. 

Exercise 25 
i) Set up your name at 30 point in a typeface of your choice and reverse it 
ii) Repeat the exercise using a frame 

Drop shadows 

i) Draw a box around text or graphic with  

ii) Colour it black using the Colour palette and give it a Paper fill using 
Element !Fill 

iii) Put the rectangle behind the text by doing Element!Send to back 

iv) Edit!Copy then Edit!Paste to make an offset copy  

v) Element!Fill and choose Solid. Set colour to Black if necessary 

vi) Put the black rectangle behind everything else by Element!Send to back 

Exercise 26 
i) Reproduce the above example 
ii) Repeat using a frame 

Running text around graphics 

i) Select graphic 

ii) Element!Text wrap 

iii) Choose  to flow over the graphic 

  to wrap apround the sides of a rectangular shape  

  to wrap around the sides of an irregular shape  

iv) Choose one of the following to determine text flow: 

 top of graphic, then resume flowing at the next column or page  

 top of graphic, then jump to the bottom and continue flowing  

 top of graphic, wrap around sides, continue flowing from the bottom  

REVERSED 
TEXT 

This text is in 
a box with a 

drop shadow. 
It could be a 

graphic 

This text is in 
a box with a 

drop shadow. 
It could be a 

graphic 
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Adjusting the graphic boundary 

The stand-off boundary becomes visible when you select the graphic and text 
wrap is on. 

The stand-off distance, or margin, between the graphic and the text flowing 
around it is specified in the Text wrap dialog box. 

You can also use the pointer tool to reshape the boundary by dragging on a 
handle. Create a new handle by clicking once on the boundary.  

 

 
Stand-off boundary is 
the dotted line 

 

Exercise 27 

i) Go to page 1 of the publication  and move the logo into the middle of the text 
ii) Modify the graphic boundary so that the text runs around letters which make up the logo 

Rotating text and graphics 

Use the Rotation tool, , to rotate a frame, a graphic or a text block by sight. 

i) Click  and move the 
cursor to the point on the 
graphic that you want to use 
as the centre of rotation: 

ii) Press the left button and drag 
out and around to rotate the 
object: 

iii) Release the mouse: 

 

 
 

or select a rotation centre and set an angle of rotation in the Control Palette: 

 
Drop caps 

 
olor sit amet, consectetuer adipiscing elit, sed diam nonummy nibh euismod tincidunt ut 
laoreet dolore magna aliquam erat volutpat. Ut wisi enim ad minim veniam, quis nostrud 
exerci tation ullamcorper suscipit lobortis nisl ut aliquip ex ea commodo consequat. Duis 

autem vel eum iriure dolor in hendrerit in vulputate velit esse molestie consequat, vel illum 
dolore eu feugiat nulla facilisis at vero eros et accumsan et iusto odio dignissim qui blandit 
praesent luptatum zzril delenit augue duis dolore te feugait nulla facilisi. 

 

The above effect can be achieved by Utilities!Plug-ins!Drop Cap... 

 

Exercise 28 
Put drop caps on all the paragraph in the story on page 1 

D 
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Miscellaneous features 
Changing the colour of objects 

i) If necessary, Window!Show Colours to show the colour 
palette 

ii) Select the object and click on a colour 

Arranging and rearranging graphics 

You can place graphics on top of each other to achieve interesting 
effects 

You can change the order in which they are stacked by selecting one and 
then using 

 Element!Arrange and choose action to take 

Selecting and moving more than one item 

Select , then 

To Do this 

Select all items press Ctrl+A or 
Edit!Select all or 
Drag an imaginary rectangle around (marquee) all items 

Select any number of items Shift+click on each item or 
Marquee items 

Add an item or items to a selection Hold down Shift and click on item or 
Shift+Marquee a group 

Remove an item from a selection Hold down Shift and click on item 

Deselect all items Click on a white area of the display 

 

To move the selected items, drag on a non-white part of the group 

 

Styles 
Creating a style 

i) Type!Define styles and click New 

ii) Put a name in Name and change other settings as required 

Applying a style 

i) Select paragraphs to style. 

ii) Type!Style and choose style. Or select a style in the Style Palette. 

Modifying a style 

i) Type!Define style!Edit 

ii) Select style to modify and change settings as required 



 

 

 

 


